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1. Document Overview 

This document is a user manual for Accela IDE. The purpose of this document is to guide Accela configurators to perform all the scripts and 

coding required to complete all Integration tasks.  

 

The document will provide the user with detailed steps and explain how the steps should be carried out to complete tasks in Accela IDE, it 

should also introduce Accela configurators to the basic keys and commands in Accela Eclipse (Eclipse bundled with Accela plugin). 

 

2. Audience 

The targeted audience in this document are the Accela Configurators who are working in the scripting (integration) team. 

 

3. Introduction 

3.1. What is Accela IDE? 

This is eclipse bundled with Accela plugin, used to work with Accela projects. 

 

A plug-in (or add-in / addin, plugin, extension or add-on / addon) is a software component that adds a specific feature to an existing software 

application. 

 

3.2. What is Accela? 

Accela is the leading provider of civic engagement solutions for government. The Accela Civic Platform includes APIs and mobi le apps and is 

designed to enable and improve core processes for city, county, state and federal governments. Accela’s solutions uniquely address the diverse 

needs of agencies, citizens and businesses by enhancing workflow and making publicly available information more accessible. 

 

3.3. What is Eclipse? 

Eclipse is a platform that has been designed from the ground up for building integrated web and application development tooling. By design, 

the platform does not provide a great deal of end user functionality by itself. The value of the platform is what it encourages: rapid 

development of integrated features based on a plug-in model. 

Eclipse provides a common user interface (UI) model for working with tools.  It is designed to run on multiple operating systems while 

providing robust integration with each underlying OS.  Plug-ins can program to the Eclipse portable APIs and run unchanged on any of the 

supported operating systems.  

At the core of Eclipse is an architecture for dynamic discovery, loading, and running of plug-ins. The platform handles the logistics of finding 

and running the right code. The platform UI provides a standard user navigation model.  Each plug-in can then focus on doing a small number 

of tasks well. What kinds of tasks? Defining, testing, animating, publishing, compiling, debugging, diagramming, etc… 

 

  

To learn more about Eclipse, visit the link below: 
http://help.eclipse.org/mars/index.jsp?topic=%2Forg.eclipse.platform.doc.isv%2Fguide%2Fint_eclipse.htm    

https://en.wikipedia.org/wiki/Software_component
https://en.wikipedia.org/wiki/Software_application
https://en.wikipedia.org/wiki/Software_application
http://help.eclipse.org/mars/index.jsp?topic=%2Forg.eclipse.platform.doc.isv%2Fguide%2Fint_eclipse.htm
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4. Installation of Accela IDE 

4.1. Installation Prerequisites 

To install Accela IDE, make sure of the below prerequisite ahead: 

 

1. Install JDK 1.7 or above, on your machine. 

 

  
To check whether the JDK 1.7 is already installed on your machine, use the command appears in the below figure: 

 

Figure 1: Java version - CMD Command 

 

 

  

Use the link below to download Java development kit, in case it is not already installed on your machine: 
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html    

 

 

4.2. Installation Steps 

Once you have completed all the prerequisites, follow the below steps in order to install Accela IDE: 

 

1. Go to https://eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/mars/1/eclipse-jee-mars-1-

win32-x86_64.zip and download eclipse 

2. Extract the zip file on your hard disk, example d:\soft\AccelaIDE 

3. Once the installation is done, you can run eclipse, by navigating to the destination folder then to double click on the eclipse 

application icon, as appear in below figure. 

http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
https://eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/mars/1/eclipse-jee-mars-1-win32-x86_64.zip
https://eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/mars/1/eclipse-jee-mars-1-win32-x86_64.zip
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Figure 2: Running Accela IDE 

 

4. Click on help menu in eclipse and then choose install new software option, as appear in below figure: 

 

Figure 3: Install New Software 

 

5. Install pop up will appear to you: 
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Figure 4: Install Pop up 

 

6. Write http://accelamea.github.io/IDE/  in Work with textbox, then press Enter in your keyboard. 

7. From the tree view that will appear to you in the name area, expand Accela option, choose Accela IDE, then click Next button. 

8. Accept the terms of the license and click Finish button. 

9. Click Ok on the security warning. 

10. Eclipse will prompt you to restart, click Yes. 

 

  
Create a shortcut of the application in your desktop for easier navigation.  

 

 

 

 

 

http://accelamea.github.io/IDE/
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5. Getting ready  

After installation is finished, you will need to set the below in order to get ready: 

5.1. Selecting Workspace 

Once you run eclipse, the following screen will appear to select a workspace. 

 

Figure 5: Workspace Launcher 

1. Select workspace then click OK button, the application will appear as below figure: 

 

Figure 6: Eclipse Welcome Page 
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2. Close the Welcome page using the close icon next to the page title, then the Eclipse Workspace will appear to you as below: 

 

 

Figure 7: Eclipse Workspace 

 

 

 

5.2. JavaScript Perspective 

Before working with any project, you must ensure that you are working in a Java script perspective. To do so, follow below steps: 

 

1. Open perspective by clicking the Open perspective button            at the top right of the Eclipse workspace, Once you click the button, 

Open Perspective pop-up will appear to you, as shown in below figure. 
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Figure 8: Open Perspective Popup 

 

2. Select JavaScript from the list then click OK button. 

 

5.3. Setting License 

The final step in getting ready to use the application is to set the license, and to do so, follow the below steps: 

1. From the Eclipse workspace, select About Accela Plugin from Accela menu, as appear in below figure:  

 

Figure 9: Set License - Accela Menu 
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2. About Accela Eclipse Plugin pop-up will appear as below: 

 

Figure 10: About Accela Eclipse Plugin Popup 

3. Click on Get License button to get your license, then the application will automatically open the default mail application, with a ready 

email to be sent to the support, as appear in below figure: 

  
In case there is no default mail application, copy the serial number from the output screen, and email it to the support.  
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Figure 11: Accela Plugin License Request 

 

4. You will receive an email reply, with the license key, copy the key to set your license. 

5. Go back to About Accela Eclipse Plugin Popup, then click on Set License button, the following popup will appear to you: 

 

Figure 12: Insert License Key 

 

6. Copy the license key into the corresponded field then click on OK button, as appear in above screen. 

7. Your Plugin license will be activated as appear in below figure: 
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Figure 13: About Accela Eclipse Plugin - License Activated 

 

5.4. Update Accela Eclipse IDE 

To install new updates go to the Help menu, then select Check for Updates option. As appear in below figure: 

 

Figure 14: Update Eclipse 
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6. Connecting to a New Project 

Follow the below steps to connect to a new Accela project: 

 

1. From the Eclipse workspace, navigate through File menu then select New –> Other, as appear in below figure: 

 

 

Figure 15: Connect to a New Project 
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2. New pop-up will appear, select Project from Accela folder, as in below figure: 

 

Figure 16: New Project Wizard 
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3. Click Next button, then Accela Project screen will appear to you as below: 

 

Figure 17: New Project Wizard - Accela Project 

 

 

4. Fill the project information as required then click on Finish button, to start the installation. 

 

 

  

Agency field should be always capital letters. 

Do not forget to add the backslash “/” at the end of every URL, in the V360 Url and AA Url fields. 
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7. Working With Project View 

7.1. Getting Started 

To start working with projects, follow below steps: 

 

1. From the Eclipse workspace, Go to window menu in the menu bar, then click on Show View  Project Explorer to get the 

project explorer view – in case if it is not already in the project explorer view. 

 

Figure 18: Project Explorer View 

 

2. To get the Accela Project View window, click on the Open Project View icon   from the toolbar, to be viewed as appear as 

in below figure: 

 

Figure 19: Open Project View – Accela Project View 
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3. If the connection is time-out then click on the Refresh Connection   button that appear in above figure, to view your 

project, as appear in below figure:  

 

 

Figure 20: Working With Project 
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4. By expanding your project View, your project’s elements will be shown in a tree view as shown in below figure:  

 

Figure 21: Project View Components 

 

 

 

 

5. The below table explains the project tree view elements: 

 

 

 



 

 

 

ECLIPSE PLUGIN 

 ECLIPSE PLUGIN 

VERSION 1.00 

13.10.2015  
PAGE 

 24 | 44 

Table 1: Project View Elements 

Element 
Number  

Element 
Icon 

Element Name Description 

1 

 

Project Root   

2 

 

Modules  List of different services departments  

3 

 

Module   

4 

 

Module Type   

5 

 

Module Sub Type  

6 

 

Module Category  Which inside you will find the ASI, ASIT and scripts related to the record 
type (equivalent to record type) 

7 

 

ASI Node  

8 

 

ASI Form  

9 

 

Event  

10 

 

Expression Double click the expression name to open it. 

Disabled expressions will appear in different icon shown below: 

 

11 

 

ASI subgroup   

12 

 

Field  

13 

 

ASIT Node  

14 + 15 

 

Scripts  
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If script/expression are changed, an overlapped icon appear on top of the original icon. 

  
Script are displayed based on the record type, script type or event. Also the include scripts will be displayed under each 
script. 

 

 

 

7.2. Actions Index 

The below table lists a description for each action available for the elements explained in above section:  

 

Table 2: Accela IDE Actions 

Action Icon Action Name Action Context  Description 

 

Copy Name  All Copy the name of the form/event/expression 

 

Refresh Project root Refresh the project tree from local files 

 

Override And 
Update 

Project root For more details click here 

 

Synchronize Project root For more details click here 

 

Generate 
Autocomplete 

Project root Generate autocomplete script for aa API 

 

Update Module, Expression, 
Script   

Update the node data from the server 

 

Generate 
Scripts 

Record type node For more details click here 

 

Copy Record 
Script  

Record type node  generate default include script for this record type, and copy it to 
the clipboard 

 

Copy Table 
Script 

ASI and ASIT groups 
node 

Generate default script for expression on this group, and copy it 
to the clipboard 

 

Copy Qualified 
Name 

Record type node Copy the qualified name of this node 
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New 
Expression 

Event Creates a new expression 

For more details click here 

 

Disable/Enable Expression Enable / Disable expression 

 

Compare With 
Server 

Expression, Script Compare the script with the version on the server 

 

Compare With 
Local File 

Expression, Script Compare the script with the local version 

 

Push to server Expression, Script Push the changes to the server 

 

Mark as 
merged 

Expression, Script In case of conflict with another user who changed the 
document’s contents, the file will be marked as merged in order 
to be able to push it to the server 

 

Delete Expression, Script Delete script from the server 

 

New Script Scripts Node For more details click here 

 

Export Record Node Export the scripts and expressions of this record type to a desired 
folder on your desktop 

 

Open Script Scripts Node  Download a script from the server 

 

Test Script Toolbar Test the script in the active editor against the server, and write 
the result in Accela console.  

If you need to check the server log, select the Show Server Log 
from Accela menu in the menu bar. 

 

Auto Filter Toolbar The will do the link between the opened file and the project view 
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7.3. Actions Details  

 

Below is the description for some of the above mentioned actions: 

 

7.3.1 Override And Update  

Use this action in order to Override and update your project, by clicking this action the following pop-up will appear: 

 

 

Figure 22: Override And Update Project Popup 

 

This allows for updating the project info where it has different options to do so, click All button. 

 

Script List—updates script lists only, favorite scripts- the ones already used. These options will delete everything and replace whatever has 

been chosen, all the local changes will be lost. 

 

7.3.2 New Script  

Use this action in order to generate new scripts, by clicking this action the following popup will appear: 

 

 

Figure 23: New Script Popup 

 

Fill the required fields appear in above figure then click OK button to generate your script. 
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7.3.3 New Expression  

Use this action in order to generate new Expressions, by clicking this action the following pop-up will appear: 

 

 

Figure 24: New Expression Popup 

 

Fill the required fields appear in above figure then click OK button to generate new expression. 
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7.3.4 Generate Scripts  

 

Use this action in order to generate new Scripts, by clicking this action the following popup will appear: 

 

 

Figure 25: Generate Scripts Popup 

 

Click the checkboxes related to the scripts you would like to generate as appear in above figure then click OK button to generate the selected 

scripts. 

 

The scripts will be generated and pushed to server 
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7.3.5 Import and Export  

 

You will be able to export or to import expressions on the ASIT level to or from Excel files, by selecting the expression, right click on it, then 

click on Export or Import option. As appear in below figure: 

 

 

 

Figure 26: Export & Import Actions 
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7.4. Release Notes  

 

You can create a release notes for the changes you have made in Accela Eclipse IDE using below steps: 

 

1. From Accela Project View, right click Releases option then select New Release option, New Release Note pop up will appear to you 

as in the following figure: 

 

Figure 27: New Release Note Pop Up 

 

2. The new release note will appear to you in the tree view, right click on it then select Add to Release option to add the objects that 

have been affected with your updates. The following pop up will appear to you: 

 

Figure 28: Add to Release Note Pop up 

 

3. Select the type of the object that has been added to the release. 

4. Insert the name of the object in Name field. 

5. Insert your comments then click OK button. 
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6. After creating the objects types that have been affected with your changes, you can select two or more, as needed, then click Merge 

option to merge them in one file. 

7. You can export the release note into Excel file by right click the new release note in the tree view then select Export option. 

8. As a shortcut you can select objects of types Expression, Script, and Record that have been already created in the project and right 

click on it then select Add to Release options to add them on the release note. 

 

 

7.5. Server Log  

 

You can view the log for the business servers for this project of this project by selecting the server, right click on it, then select Get Log, the 

server log will be viewed to you in the Console as appear in below figure: 

 

 

Figure 29: Server Log 
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8. Working with Synchronize View 

 

To synchronize project, click on the related action as described in the actions table above, then Accela Synchronize View tab will appear as 

shown below: 

 

 

Figure 30: Accela Synchronize View Tab 

 

 

 

8.1. Types of Synchronization Results 

By synchronizing your project there is three types of results will appear to you, as listed below: 

 

1. Incoming: where the updates on the project have been made by others, and it is represented by incoming icon . 

2. Outgoing: where the updates on the project have been made by you, and it is represented by outgoing icon . 

3. Conflict: where the updates on the project have been made by others and you, and it is represented by conflict icon  
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8.2. Actions on Synchronization Results 

 

You can find a list of the actions available on the synchronization results in the below table:  

 

Table 3: Synchronization Results Actions 

Action Icon Action Name Action Availability  Description 

 

All  Toolbar Click on it to view all type of synchronized items  

 

Incoming  Toolbar Click on it to view synchronized items that have been updated by 
others 

 

Outgoing Toolbar Click on it to view synchronized items that have been updated by 
you 

 

Conflict  Toolbar Click on it to view synchronized items that have been updated by 
others and you 

 

Synchronize Toolbar, right click 
on expression root. 

Shortcut for synchronize action button 

 

Compare With 
Server 

context menu For more details go back to Table 1. 

 

Compare With 
Local File 

context menu For more details go back to Table 1. 

 

Push to server context menu For more details go back to Table 1. 

 

Update context menu For more details go back to Table 1. 

 

Mark as 
merged 

context menu For more details go back to Table 1. 

 

 

 

  

Double clicking the node will open the compare with server action. 

View the link below for more information on the compare feature: 

http://help.eclipse.org/mars/index.jsp?topic=%2Forg.eclipse.platform.doc.user%2Freference%2Fref -25.htm  

 

 

 

http://help.eclipse.org/mars/index.jsp?topic=%2Forg.eclipse.platform.doc.user%2Freference%2Fref-25.htm
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9. Working With Translation View 

Accela IDE gives you the ability to save new keywords with their translations in several languages and to check in case the translation is already 

exist by searching for it, to do so follow below steps: 

 

1. Select Translations from Accela menu in the toolbar to view Accela Translator tab, as appear in below figure: 

 

Figure 31: Accela Translator Tab 

 

2. To search for translations available, insert the translation key in Key field, if available, then click Search button, the translation 

information will appear if the translation key is available, if not, warning message will appear as below: 

 

Figure 32: Translation Key Not Found MSG 

 

3. To insert new translation, insert the terminology in EN field then click on Translate From EN button related to each language field in 

order to translate the requested keyword, the translations will be based on the most common terminologies used in Accela 

applications. 

4. To check the spelling for the terminology click on Spell Check button.  

5. To save the new translation click on save icon in the tab toolbar. 

6. If the translation is already exist, a warning pop up message will appear to you, then you can check the translation key for the already 

exist translation in the console, as appear in below figure.  
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Figure 33: Console Tab 

 

 

10. Working With Queries View 

You will be able to run queries using Accela IDE, and to do so follow below steps: 

 

1. Select Query Executor from Accela menu in the toolbar to view Accela Query Executor tab, as appear in below figure: 

 

Figure 34: Accela Query Executor Tab 

 

2. To run new query, insert your query in the textbox shown above the queries table, as appear in below figure, then press enter key, to 

execute the query as appear in below figure: 
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Figure 35: Accela Query Executor Tab - Run Query 

 

3. You can run queries from history, by selecting the query from the list that will appear to you using the arrow at the right top of the 

Accela Query Executor tab, as shown in below figure: 

 

 

Figure 36: Accela Query Executor Tab - Run Query From History 
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11. Standard choices 

Accela IDE gives you the ability to navigate through the standard choices available in Accela application, and to do so follow below steps: 

 

1. Select STD Choice from Accela menu in the toolbar, as appear in below figure: 

 

Figure 37: STD Choice 

 

2. The following pop up will appear to you in order to select the standard choice you want to open:  

 

Figure 38: Standard Choices Popup 
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3. Filter for the standard choice you want to open by typing its name in the related textbox, then double click on it to view the standard 

choice keys and values, as appear in below figure: 

 

Figure 39: Standard Choices Key & Value Popup 

 

4. Double click the key and value record to copy to clipboard (multi-selection is applicable). 
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12. Settings 

 

To manage Accela IDE Preferences, Select Preferences option from Window menu in the toolbar, as appear in below figure: 

 

 

Figure 40: Preferences 
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12.1. Console 

1. Once you choose Preferences option from Window menu, the Preferences pop up will appear to you, then Select Accela -> Console 

to manage your console options, as appear in below figure: 

 

Figure 41: Console 
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12.2. Notifications 

1. Click on Notifications from Accela option to manage your notifications, as appear in below figure: 

 

Figure 42: Notifications 

2. Click the checkboxes for the desired options then click on Apply button to apply changes. 
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12.3. Query Executor 

1. Click on Query Executor from Accela option to manage your query executor, as appear in below figure: 

 

Figure 43: Query Executor 

 

 

Below is the description of above fields: 

 

a. Sql History size: shows the history size in Accela IDE 

b. Sql Where Filter: it makes an automatic filter to any script at the specified entry data 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

ECLIPSE PLUGIN 

 ECLIPSE PLUGIN 

VERSION 1.00 

13.10.2015  
PAGE 

 44 | 44 

 

 

12.4. Scripts 

1. Click on Scripts from Accela option to manage your scripts, as appear in below figure: 

 

Figure 44: Scripts 

 

Below is the description of above fields: 

 

a. Auto clear Cache after commit: makes an automatic clearance after committing the script 

b. Auto clear console before script test: it will automatically clears the script console after performing the test 

c. Script Test Include File: to include the master file in each test script operation 

d. Script Test Transaction Commit: to commit or roll back a script 

 


